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Introduction 

The SISTE driver enables communication between the Studio system and Sistema CP-3000 devices with serial 

communication, according to the specifications discussed in this document.  

This document was designed to help you install, configure, and execute the SISTE driver to enable 

communication with these devices. The information in this document is organized as follows: 

 Introduction: Provides an overview of the SISTE driver documentation. 

 General Information: Provides information needed to identify all the required components (hardware and 

software) used to implement communication between Studio and the SISTE driver.  

 Installing the Driver: Explains how to install the SISTE driver. 

 Configuring the Driver: Explains how to configure the SISTE driver. 

 Executing the Driver: Explains how to execute the driver to verify that you installed and configured the  

driver correctly.    

 Troubleshooting: Lists the most common error codes for this protocol and explains how to fix these errors. 

 Sample Application: Explains how to use a sample application to test the SISTE driver configuration. 

 Revision History: Provides a log of all modifications made to the driver and the documentation.  

 Notes:  

• This document assumes that you have read the “Development Environment” chapter in the Studio 
Technical Reference Manual. 

• This document also assumes that you are familiar with the Windows NT/2000/XP environment.  
If you are unfamiliar with Windows NT/2000/XP, we suggest using the Help feature (available from the 
Windows desktop Start menu) as you work through this guide.  
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General Information 

This chapter explains how to identify all the hardware and software components used to implement 

communication between the Studio SISTE driver and the Sistema CP-3000 devices.  

The information is organized into the following sections: 

 Device Characteristics 
 Link Characteristics 
 Driver Characteristics 

Device Characteristics 

To establish communication, you must use devices with the following specifications:  

 Manufacturer: Sistema 
 Compatible Equipment:  

– CP-3000 

 
 Programming Software: None 

 Device Runtime Software: None 

 

For a list of the devices used for conformance testing, see “Conformance Testing”. 

Link Characteristics 

To establish communication, you must use links with the following specifications: 

 Device Communication Port: Serial COM Port 

 Physical Protocol: Serial RS232 

 Logic Protocol: Proprietary 

 Specific PC Board: None 

Driver Characteristics 

The SISTE  driver is composed of the following files: 

 SISTE.INI: Internal driver file. You must not modify this file. 

 SISTE.MSG: Internal driver file containing error messages for each error code. You must not modify this file.  

 SISTE.PDF: Document providing detailed information about the SISTE driver. 

 SISTE.DLL: Compiled driver. 

 





Notes:  

• All of the preceding files are installed in the /DRV subdirectory of the Studio installation directory.  

• You must use Adobe Acrobat® Reader™ (provided on the Studio installation CD-ROM) to view  
the SISTE.PDF document. 

 

You can use the SISTE driver on the following operating systems:  

 Windows NT/2K/XP 

 

For a list of the operating systems used for conformance testing, see “Conformance Testing”.  
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Conformance Testing 

The following hardware/software was used for conformance testing: 

 Driver Configuration: 

– COM Port: COM 1 

– Baud Rate: 9600 

– Data Bits: 8 

– Stop Bits: 1 

– Parity: None 

– 0-Mono 1-Multi(Process.): 0 

 Cable: According to specifications described in the “Link Characteristics” section 

 

Driver 

Version 

Studio 

Version 

Operating 

System 
Equipment 

1.00 6.0 Win2K Sistema CP-3000 
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Installing the Driver 

When you install Studio version 6.0 or higher, all of the communication drivers are installed automatically.  

You must select the driver that is appropriate for the application you are using. 

Perform the following steps to select the driver from within the application: 

1. Open Studio from the Start menu.  

2.   From the Studio main menu bar, select File Open Project to open your application. 

3.   Select Insert Driver from the main menu bar to open the Communication drivers dialog.  

4.   Select the SISTE driver from the Available Drivers list (as shown in the following figure), and then click the 
Select button.  

 

Communication Drivers Dialog Box 

5. When the SISTE driver displays in the Selected Drivers list, click the OK button to close the dialog. 

 

 Note:    

It is not necessary to install any other software on your computer to enable communication between the 
host and the device. 

 
 

 Attention:    

For safety reasons, you must use special precautions when installing the physical hardware. Consult the 
hardware manufacturer’s documentation for specific instructions in this area. 
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Configuring the Driver  

After opening Studio and selecting the SISTE driver, you must configure the driver. Configuring the SISTE driver 

is done in two parts: 

 Specifying communication parameters 

 Defining tags and controls in the STANDARD DRIVER SHEETs (or Communication tables) 

Worksheets are divided into two sections, a Header and a Body. The fields contained in these two sections 

are standard for all communications drivers — except the Station, Header, and Address fields, which are driver-

specific. This document explains how to configure the Station, Header, and Address fields only. 

 

 Note:    

For a detailed description of the Studio STANDARD DRIVER SHEETs, and information about configuring 
the standard fields, review the product’s Technical Reference Manual.  

 

Setting the Communication Parameters 

Use the following steps to configure the communication parameters, which are valid for all driver worksheets 
configured in the system: 

1. From the Studio development environment, select the Comm tab located below the Workspace. 
2.   Click on the Drivers folder in the Workspace to expand the folder.  
3.   Right-click on the SISTE subfolder and when the pop-up menu displays, (as shown in the following figure) 

select the Settings option. 

 

Select Settings from the Pop-Up Menu 

The SISTE: Communications Parameters dialog displays (as follows). 

 

Communication Parameters Dialog 
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4. Specify the custom parameters as noted in the following table: 

 

Parameters Default Values Valid Values Description 

Station 0 Any number Computer number in the network 

0-Mono 
1-Multi (Process.) 

0 0 or 1 
0: Mono processor Protocol 
1: Multi processor Protocol 

 
 
 

 Note:    

The device must be configured with exactly the same parameters that you configured in the SISTE 

Communication Parameters dialog.  

 

5. Click the Advanced button on the Communication Parameters dialog to open the Advanced Settings dialog and 

configure the settings that are necessary. 
 

 Notes:    

 Do not change any of the other Advanced parameters at this time. You can consult the Studio 
Technical Reference Manual for information about configuring these parameters for future reference. 

 Generally, you must change the Advanced parameter settings if you are using a DCE (Data 
Communication Equipment) converter (232/485 for example), modem, and so forth between the  
PC, driver, and the host. You must be familiar with the DCE specifications before adjusting these 
configuration parameters.  
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Configuring the Driver Worksheets 

This section explains how to configure the STANDARD DRIVER SHEETs (or communication tables) to associate 

application tags with the device addresses. You can configure multiple Driver Worksheets — each of which is 

divided into a Header section and Body section.  

Configuring the STANDARD DRIVER SHEET 

 

Use the following steps to create a new STANDARD DRIVER SHEET: 

1. From the Studio development environment, select the Comm tab, located below the Workspace pane. 

2. In the Workspace pane, expand the Drivers folder and right-click the SISTE subfolder.  

3. When the pop-up menu displays (as shown in the following figure), select the Insert option. 

 

Inserting a New Worksheet 

 

 Note:  

To optimize communication and ensure better system performance, you must tie the tags in different 

driver worksheets to the events that trigger communication between each tag group and the period in 

which each tag group must be read or written. Also, we recommend configuring the communication 

addresses in sequential blocks to improve performance. 
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The STANDARD DRIVER SHEET displays (similar to the following figure). 

 

STANDARD DRIVER SHEET 

In general, all parameters on the Driver Worksheet (except the Station, Header, and Address fields) are standard 

for all communication drivers, but they will not be discussed in this document. For detailed information about 

configuring the standard parameters, consult the Studio Technical Reference Manual.  

4.   Use the following information to complete the Station, Header, and Address fields on this worksheet.  

 Station field: Specify the device using the following syntax: 

<Station number>:<PLC Type>  

Where: 

– Station number is the remote PLC number. For R-NET processor, configure the node number. For 

serial communication processor use the SLOT number. 

– PLC Type is the type of the remote PLC. Valid values: A15, A20, A30, A30E, A40 and A40E. 

 Header field: Use the following information to define the type of variables that will be read from or written to 
the device and a reference to the initial address. 

These variables must comply with the following syntax: 

<Slot DST>:<Slot SRC>:<Addr>:<Command>  

Where: 

– Slot DST is the SLOT destination number (octal). 

– Slot SRC is the SLOT source number (octal). 

– Addr is the initial register address which will be read or written. (octal) 

– Command is the number of the command used to read or write. Valid commands: 46, 47, 50 and 72 

(octal). This field is optional and it must be left blank if you are not using these commands. 
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To configure an worksheet for unsolicited messages, add “U:” as the prefix of the Header field and configure 
only the <Station number> in Station field. E.g.: Header U:0:0:10 and Station 1 

 

After you edit the Header field, Studio checks the syntax to determine if it is valid. If the syntax is incorrect, 

Studio automatically inserts the default value in the Header field. 

Also, you can type a tag string in brackets {Tag} into the Header field, but you must be certain that the tag’s 

value is correct and that you are using the correct syntax, or you will get an invalid Header error.  

The following table lists the commands that are valid for the SISTE driver.  

Command Tag Type Read Write Comments 

46 Integer  • 

Write the number of nodes in network. 
When configuring the command 46 in the Header field, the value configured in the Address 
column (if any) is ignored. The value of the tag configured in the Tag Name column of the driver 
worksheet (Integer type) must be the number of nodes in network (decimal). 

47 String  • 

Write the node number, the number of nodes and configurations in network. 
When configuring the command 47 in the Header field, the value configured in the Address 
column (if any) is ignored. The value of the tag configured in the Tag Name column of the driver 
worksheet (String type) must be <node number>:<number of nodes>:<config> (e.g.: 2:5:10) 
Where: 
<node number> is the node number (decimal) 
<number of nodes> is the number of nodes (decimal) 
<config> is configuration code to determine protocol and timing parameters. (octal). 

50 Integer •  

“Who are you?” command 
When configuring the command 50 in the Header field, the value configured in the Address 
column (if any) is ignored. You must configure fourteen tags (Integer type) in the driver worksheet 
to receive the values.  

72 Any  • 

Status of communication with the Gateway 
When configuring the command 72 in the Header field, the value configured in the Address 
column (if any) is ignored. Only one tag must be configured in the Tag Name column of the driver 
worksheet (any type). The status of the communication with the gateway is returned to the tag 
configured in the Write Status field of the driver worksheet (0 = OK; 50 = Error). 

<blank> Integer • • Read or Write registers 

 

 Address field: Use this field to associate each tag to its respective device address. 

Type the tag from your application database into the Tag Name column. This tag will receive values from or 
send values to an address on the device. The address must comply with the following syntax: 

<AddressOffset>.[Bit] (For example: 10, 20, 40, 10.5) 

Where: 

– AddressOffset is an offset added to the Addr parameter (configured in the Header field) to compose the 

group address.  

– Bit (optional parameter) is the bit number to be read from or written to the device. 

Attention:  

You must not configure a range of addresses greater than the maximum block size (date buffer length) 

supported by each PLC within the same worksheet. The maximum data buffer length for this driver is 

122 operands per STANDARD DRIVER SHEET. 


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Executing the Driver  

After adding the SISTE driver to a project, Studio sets the project to execute the driver automatically when you 

start the run-time environment.  

To verify that the driver run-time task is enabled and will start correctly, perform the following steps: 

1. Select Project → Status from the main menu bar. 

The Project Status dialog box displays, as follows.  

 

Project Status Dialog Box 

2.   Verify that the Driver Runtime task is set to Automatic. 

 If the setting is correct, click OK to close the dialog box.  

 If the Driver Runtime task is set to Manual, select the Driver Runtime line. When the Startup button becomes 
active, click the button to toggle the Startup mode to Automatic.  

3.   Click OK to close the Project Status dialog.  

4.   Start the application to run the driver. 
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Troubleshooting 

If the SISTE driver fails to communicate with the device, the tag you configured for the Read Status or Write Status 

fields will receive an error code. Use this error code and the following table to identify what kind of failure 

occurred.  

 

Error Code Description Possible Causes Procedure to Solve 

0 OK Communication without problems None required. 

22 Block Size Error Only 122 operands is allowed per Driver Worksheet. Split the Driver Worksheet in two or more 

20 Invalid Address Specified an invalid address in the Driver Worksheet. Check the address configured in Driver Worksheet. 

30 Invalid Header Specified an invalid header in the Driver Worksheet. Check the header configured in Driver Worksheet. 

40 Invalid operation Try read or write an Unsolicited Driver Worksheet You cannot read or write in these header 

50 Error Gateway Error communication with Gateway 

 Check the configuration of the driver’s 

communication parameters. 

 Check the equipment state. 

60 No message Invalid unsolicited message Check Unsolicited messages 

80 Invalid message Invalid Message 

 Check the configuration of the driver’s 

communication parameters. 

 Check the equipment state. 

-15 
Timeout Start 
Message 

 Disconnected Cables 
 PLC is turned off, in stop mode, or in error mode 
 Wrong station number 
 Wrong RTS/CTS control settings 

 Check cable wiring 
 Check the PLC state – it must be RUN. 
 Check the station number 
 Check the configuration. See Studio Technical 

Reference Manual for information about valid 
RTS/CTS configurations. 

-17 
Timeout between 
rx char 

 PLC in stop mode or in error mode 
 Wrong station number 
 Wrong parity 
 Wrong RTS/CTS configuration settings 

 Check cable wiring 
 Check the PLC state – it must be RUN. 
 Check the station number 
 Check the configuration. See Studio Technical 

Reference Manual for information about valid 
RTS/CTS configurations. 

 

 

 Tip:  

You can verify communication status using the Studio development environment Output window (LogWin 

module). To establish an event log for Field Read Commands, Field Write Commands, and Serial Communication 

right-click in the Output window. When the pop-up menu displays, select the option to set the log events. If 

you are testing a Windows CE target, you can use the Remote LogWin of Studio (Tools  Remote Logwin) to 

get the log events from the target unit remotely. 

 

If you are unable to establish communication with the PLC, try to establish communication between the PLC 

Programming Tool and the PLC. Quite frequently, communication is not possible because you have a hardware 

or cable problem, or a PLC configuration error. After successfully establishing communication between the 

device’s Programming Tool and the PLC, you can retest the supervisory driver. 
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To test communication with Studio, we recommend using the sample application provided rather than your new 

application. 

If you must contact us for technical support, please have the following information available: 

 Operating System (type and version): To find this information, select Tools → System Information.  

 Studio version: To find this information, select Help → About. 

 Driver Version: To find this information, read the full description of the driver on the Communication Drivers 

Dialog Box. 

 Communication Log: Displays in the Studio Output window (or LogWin window) when the driver is running. Be 

sure to enable the Field Read Commands, Field Write Commands, and Serial Communication for the LogWin window. 

 Device Model and Boards: Consult the hardware manufacturer’s documentation for this information. 
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Sample Application 

 

You will find a sample application for drivers in the /COMMUNICATION EXAMPLES/<Driver Name> directory. 

We strongly recommend that you check if there is a sample application for this driver and use it to test the driver 

before configuring your own customized application, for the following reasons: 

 To better understand the information provided in the section of this document. 
 To verify that your configuration is working satisfactorily. 
 To certify that the hardware used in the test (device, adapter, cable, and PC) is working satisfactorily before 

you start configuring your own, customized applications. 
 

Note:  

This application sample is not available for all drivers.  

 

Use the following procedure to perform the test: 

1. Configure the device’s communication parameters using the manufacturer’s documentation. 

2. Open and execute the sample application. 

 Tip:  

You can use the sample application screen as the maintenance screen for your custom applications.  
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